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1 Introduction

Thank you very much for choosing to use AmadeusPro. This is a very high quality feature-packed audio
editor which is nevertheless easy to use and very reasonably priced.

This manual will guide you through the main features of AmadeusPro. It is not intended to be an exhaustive
reference text, but it will focus on those features that are maybe not absolutely intuitive at first glance. The
best way by far to find out how a feature that is not covered in detail by this manual works is to simply try
it out and see what happens. Most of the time, it should be pretty much what you expected from the name
of the command and / or from the conventions in use by most Mac OS applications. You should not be
shy about trying functions out, since destructive actions can always be undone, unless a specific warning is
given that this is not the case.

This manual also assumes that you are reasonably familiar with computers and know how to use basic
Mac OS applications. (Think of this as your car manufacturer assuming that you actually passed your
drivers license test before buying a car from him.) In particular, it assumes that you know about files,
windows, the menu bar, etc. If you have little familiarity with sound editing, it is probably a good idea to
start by reading Sections 2 and 5 in their entirety, since these sections explain the basic terminology and
concepts used in this manual.

This manual is a PDF file with hyperlinks. All words written in blue (this includes not only URL’s but also
references to sections and page numbers for example) are clickable. Some terms that may not familiar to
everyone are linked to their Wikipedia entries. This is why no glossary is provided, since the Wikipedia
entries are usually quite well written and more complete than any glossary that could be provided here. It
is hoped that these Wikipedia links are stable, but it may of course happen that they break sometime in the
future. If you find a broken link, please inform me by sending an email to Martin@HairerSoft.com.

2 Basic notions of sound editing

2.1 What is a sound?

Let’s start with the basics since, in order to understand how a sound is represented and can be manipulated
by a computer, one should have some understanding of what a sound actually is physically. In a nutshell, a
sound is a small rapid variation in the air pressure. The variation of pressure is captured by your internal ear
and transmitted to the brain, which interprets this signal as a sound.

A microphone is nothing but an artificial ear. It measures the air pressure and transforms it into an electric
impulse. A sound is therefore usually represented as a function representing the air pressure (or equivalently
the voltage at the exit of the microphone) as a function of time. A typical representation of a sound signal
would be:

T

Note that, very often, the signal is (at least approximately) periodic as in the picture above. The time interval
between two identical looking chunks of the signal, denoted by T in the picture above, is called the period
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of the signal and is usually measured in milliseconds. The inverse of the period is called the frequency of the
signal and is measured in Hertz, also abbreviated by Hz. Some high-frequency sound signals are measured
in kiloHertz (that is thousands of Hertz), also abbreviated by kHz. A Hertz is the inverse of a second. So a
sound with a period of 0.05 seconds has a frequency of 1/0.05 = 20 Hertz. The human ear can hear sounds
that have frequencies ranging approximately between 20Hz and 20kHz. These bounds however vary with
age, wit older people less able to perceive high frequencies. Sounds with frequencies lower than that are
called infrasounds and sounds with frequencies higher than that are called ultrasounds.

2.2 How does a computer represent it?

A computer can only handle discrete pieces of data. A signal like the one depicted above will therefore be
transformed into a set of discrete values. Each of these values is called a sample and the number of values
per second used to represent the signal is called its sampling rate. Therefore, if a signal has a sampling rate
of 44.1kHz (the rate used in audio CDs), then the signal is measured 44100 times per second. The individual
values making up the signal are of course discrete as well. If the signal is stored in the computer by using
2N different values, it is said to have a sampling depth of N . Sound on an audio CD has a sampling depth
of 16, meaning that it is stored using 216 = 65,536 different values. The characteristics (sampling rate
and sampling depth) of a sound are displayed in the bottom left corner of the sound window. For practical
purposes, it is usually assumed that samples take values between −1 and 1. In the previous example of a
16bit sound, this means that every sample can take 65,536 values that are equally spaced through the interval
[−1, 1]. If a sound containing samples that are close to these limits is amplified, a phenomenon known as
‘clipping’ occurs. This is when, as a result of a sound effect being applied to it, some samples ‘would like’
to take values outside of the [−1, 1] range and are forced back into it by the computer. If the sound signal
represented above was to be amplified too much, it could therefore end up looking like this:

When clipping is severe, it introduces very noticeable artifacts that are quite difficult to get rid of, one should
therefore take care to avoid it.

Humans perceive sounds with two ears. If one wishes to reconstruct accurately an auditory experience,
it is common to use two microphones, one for each ear. This is called a stereo sound. When only one
microphone is used, it is called a mono sound. The following screenshot shows how a stereo sound is
displayed in AmadeusPro:

The upper signal coresponds to the left ear and the bottom signal corresponds to the right ear.
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Note that the structure of the signal (also commonly referred to as the ‘waveform’) only becomes apparent
when one zooms into the signal. For example, in the example above, the width of the whole display only
corresponds to about 50 milliseconds (one twentieth of a second). Zooming into the display can be achieved
with the Horizontal zoom slider:

The number appearing next to the slider when you move it represents the number of samples of sound that
fit into one pixel of your screen.

When a larger portion of the sound is shown, a typical display would rather look like this:

Here, you can see that the width of the display is about one minute. At this scale, the structure of the
waveform is not apparent anymore. What you can see essentially represents the volume of the sound as a
function of time (the fatter the dark blue area, the louder the sound).

2.3 Sound intensities: dB versus percentages

The intensity of a pure sine wave is defined as the square of its amplitude. It is normalised in such a way
that a pure sine wave with the maximal amplitude has an intensity of exactly 1. Decibels (abbreviated as
dB) are a logarithmic unit that better reflects the fact that our perception of sound intensity is not linear. A
difference of 10dB corresponds to a ratio of 10 in intensity. It is normalised in such a way that a sine wave
with maximal intensity 1 corresponds to 0dB and a sine wave with intensity 0.1 corresponds to−10dB. This
is why intensity values displayed in dB will always be negative.

For ‘physical’ rather than ‘digital’ sounds, the reference is usually chosen such that 0dB corresponds roughly
to the threshold of human hearing, so you will often see sound intensity measurements with positive dB
values. Since a given physical sound can end up at any intensity in the computer, depending on the setting
of both the recording and the reproduction equipment, there is no convenient way of converting between the
two. However, differences in dB values have the same meaning in both cases.

2.4 Anatomy of an AmadeusPro document

An AmadeusPro document consists of one or more tracks. Each track consists of either a mono or a stereo
sound. Normal sound documents stored in Mp3, WAVE or AIFF files for example typically consist of only
one track. A typical document with several tracks will be displayed by AmadeusPro in the following way:
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The next sections are a short guided tour through the various elements that can be seen in this picture.

2.4.1 Tracks

This document consists of two tracks. The first track, called ‘Voice’ (tracks can be given arbitrary names)
is a mono track. On a multichannel sound interface, it would be played back in the front. The second track,
called ‘Background music’ is a stereo track. On a multichannel sound interface, it would be played back
in the back. For more information on sound playback, see Section 4.2. In particular, see Section 4.3 for
information about the meaning of the Playback pop-up menu. One of the tracks is considered to be the
current track. The other tracks are drawn in a slightly lighter shade (in this example, the current track is the
‘Background music’ track). The current track can be changed by simply clicking anywhere in it. This is the
track on which sound effects and editing operations are applied.

2.4.2 Playback volume and envelope

You can also see on this picture that each track can be associated with a playback volume. In this example,
the ‘Background music’ would be played at a lower volume than the ‘Voice’ track. Furthermore, each track
has a playback envelope, that is represented as a thick blue line which connects knobs. New knobs can be
added to the playback envelope by simply clicking on it. A knob can be removed by dragging it out of the
window. The first and the last knob are fixed and cannot be removed. The playback envelope allows you to
change the volumes of different sections of a sound independently.

The Apply Envelope to Track function from the Sound menu allows you to apply the playback envelope
to the current track. Here is an example illustrating this:
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In the first picture, you see a track with a volume envelope that causes the volume of the track to gradually
increase from 0 to the maximal volume. After selecting Apply Envelope to Track, this changing volume
has been applied to the waveform, which you can now see taking increasingly larger values as time goes
on. The playback envelope on the other hand has been reset to the default value of being constant at the
maximal value throughout the whole track. Playing back the track produces the exact same output in both
cases.

2.4.3 Selection

Each of the tracks can have a portion of it selected. In this example, the portion of sound between about
11.5 and 15 seconds from the start is selected in the ‘Background music’ track. The ‘Voice’ track has an
empty selection. In this case, an insertion point is drawn in red. This is where the program would insert a
sound if you copied and pasted it from another document. The selection can be changed by clicking into the
sound and then dragging the mouse (with its button still pressed down) until the desired portion is selected.

If a track contains two channels, it is possible to select only the left (respectively right) channel by clicking
near the top (respectively the bottom) of the track in question. In this case, the ‘cross’ cursor will be modified
to show a small ‘L’ (respectively ‘R’). This allows for example to apply an effect to one channel only.

It is possible to preview the effect of an edit before actually performing it. If the selection is empty and
one hits the ‘e’ key, AmadeusPro will play a short portion around the selected area of the current track, but
omitting the selection in question. This allows to check for example whether cutting away a piece of sound
will introduce a small artifact or not. One way of avoiding the creation of artifacts is to use the ‘Extend to
Crossing’ function in the ‘Selection’ menu. The length of the preview can be adjusted with the ‘Length of
edit preview’ function of the ‘General’ preferences pane.

2.4.4 Playback head

The green shape located in the timescale at around 20 seconds is the playback head. This is where playback
would start (resume) if you hit the space bar. For more information on sound playback, see Section 4.2.
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2.4.5 Markers

As one can see in the screenshot, a document can have an arbitrary num-
ber of markers (‘Music faded in’, ‘Start of voice’, etc). These are just
handy ways of remembering a particular location in a document. In or-
der to create a marker, simply click in the white / gray area at the top of
the window or move the insertion point to the correct location and type
‘m’. Markers can also be given colors, for example in order to distinguish
between markers that serve different purposes. One convenient way of
working with markers is the Markers tool that can be accessed from the
Windows menu. When you click on a marker in this tool, the display of
the current window changes so that the clicked marker is moved to the
center of the window. If you use shift-click to select several markers, the display is zoomed out (or in) in
such a way that all the selected markers fit within the width of the current window. If Adjust selection is
checked, then the selection of the current track is adjusted so that it selects the portion of sound between the
chosen markers. If only one marker is chosen, it moves the insertion point to the location of that marker.
The ‘+’ button creates a marker at the center of the selection of the current track or at the insertion point if
the selection is void. The ‘-’ button allows you to delete the selected marker(s).

The four last items in the Selection menu are devoted to the management of markers. Since the meaning of
the first two should be obvious, let us only concentrate on the function of the remaining two:

• Generate Markers... Allows to generate equidistant markers on your sound. This is especially useful
in conjunction with the Split According to Markers... function if you want to cut a very long sound
into pieces of reasonable size.

You can choose Search for silences in order to place markers at the location of silences in your sound.
The Maximal level parameter gives the threshold under which a sound is considered to be silence.
The Minimal length parameter gives the minimal length a silence must have in order to be taken into
account.

If a number is found in the marker name entered in the First marker text field, it is automatically
incremented for each subsequent marker.

• Modify Markers... This item allows to modify all the markers of a file in one go. If Change name
is checked, AmadeusPro will use the corresponding name for the first marker and will try to make
a guess on how to increment it for the subsequent markers. For example, if you specify ‘Track 01’,
the next markers will be called ‘Track 02’, ‘Track 03’, etc. The Align position field allows to align
the marker positions on a specified time grid. For example, specifying ‘75 Hz’ for a file sampled
at 44.1kHz allows to align markers with sector boundaries on an Audio CD (tracks on Audio CD’s
always have a length that is a multiple of 1/75th of a second). This is useful to burn a CD without
gaps between songs.

2.4.6 Metadata

An AmadeusPro document can furthermore contain arbitrary amounts of metadata, that is data which
is not directly relevant to the editing and playback of a sound, but which gives some additional
information. Examples of metadata are the song and artist’s name, album cover artwork, etc.
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Metadata can be viewed and edited by clicking on the Information button in the toolbar or by selecting
Show Sound Info... in the Sound menu. This will also show some generic information about the sound,
like its length, file format, sampling rate, etc.

3 File Formats

AmadeusPro supports a variety of popular sound formats, as well as its own ‘Amadeus’ format. Most
formats have some limitations that prevent them from being able to represent an AmadeusPro document
faithfully. It is therefore recommended to always work in the ‘Amadeus’ format and to export the document
to a standard format only in the very last step. The shortcomings of the various formats will be explained
below.

As a general fact, sound documents can take up a large amount of disk space, and so many formats include
some compression algorithm aimed at minimising the size of the resulting file. There are two families of
such compression algorithms: lossy algorithms and lossless algorithms. Lossy algorithms allow for high
compression rates, but this comes at the cost of a loss of information. In other words, every time you decode
a document compressed with a lossy algorithm (for example to edit it) and then save it back, the sound will
lose a bit of its quality. Lossless algorithms on the other hand preserve the data in its entirety, so that there
is no loss of quality coming from successive edits. The downside of course is that lossless algorithms do not
usually achieve very high compression rates.

If you wish to edit a file encoded with a lossy algorithm, it is therefore recommended to save intermediate
steps of the editing process to an uncompressed format or a format using a lossless algorithm.

Typical lossy algorithms are Mp3, AAC and Ogg Vorbis. The AIFF and WAVE formats store uncompressed
data by default but also allow you to use lossy compression algorithms like µ-Law, a-Law, MACE-3, MACE-
6, QDesign Music 2, and AMR Narrowband. It is beyond the scope of this manual to discuss the suitability
of these algorithms for various applications. (Please don’t send me emails asking for advice. Try to experi-
ment by yourself or look for advice on the internet, there is plenty of information available online.) Typical
lossless algorithms are FLAC and Apple Lossless.

Some algorithms compress data by a fixed factor (µ-Law and a-Law compress by a factor 2, MACE-3 and
MACE-6 compress by factors 3 and 6 respectively), but most other algorithms support several compression
factors. A standard measure of compression is the bitrate which measures the amount of diskspace (in bits
per second) which the resulting file takes. A bitrate of 128kbps corresponds to about 16kB per second,
which is roughly 10 times less than the amount of disk space taken by uncompressed sound in CD quality
(44.1kHz, 16Bits, stereo). Smaller bitrates of course come at the expense of lower sound quality.

Some formats are not suitable to retain all the attributes of an AmadeusPro document. If this is the case, a
warning will be shown, together with a short explanation of the features that may be lost. The only way to
be 100% certain that all features are retained is to save a document in the AmadeusPro format.

The different file formats have specific settings that can be accessed by clicking on the Settings button in
the file saving dialog. Below is a short description of each of them.

3.1 The Amadeus format

This format is a faithful snapshot of the state of an AmadeusPro document. It is the only format that
supports all of AmadeusPro’s features without any restriction. It can only contain uncompressed data and
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has no particular settings.

3.2 The Wave format

This format is very popular mainly on the Windows platform but also on other operating systems. It usually
contains uncompressed data, but also supports a variety of compressed formats. AmadeusPro only supports
Wave files that are either uncompressed or compressed with the (lossy) µ-Law or a-Law algorithms.

The Wave format supports markers and multichannel data. AmadeusPro will try to do its best to map the
multitrack structure of the document to the ones supported by the Wave format, but this may fail if your
document contains too many different tracks.

Metadata (artwork, artist name, etc) are saved to Wave files by appending an ID3 tag at the end of the
file. This is the method employed by iTunes and should not affect the readability of the resulting file by
third-party software.

Due to the nature of the format, WAVE files are limited to 2GB in size. It is possible to encounter WAVE
files that are between 2GB and 4GB in size. Such files do not comply to the official WAVE specifications
and cannot be opened by every program supporting the WAVE format, this is why AmadeusPro will refuse
to create them. It is however able to open such files and to save them in other file formats.

3.3 The AIFF format

This format is very popular mainly on the MacOS platform. It is similarly structured to the Wave format
and usually contains uncompressed data, but also supports a variety of compressed formats.

Like the WAVE format, the AIFF format supports markers and multichannel data. AmadeusPro will try to
do its best to map the multitrack structure of the document to the ones supported by the AIFF format, but
this may fail if your document contains too many different tracks. Metadata (artwork, artist name, etc) are
also saved to AIFF files by appending an ID3 tag at the end of the file.

Due to the nature of the format, AIFF files are limited to 2GB in size. The same remark as for WAVE files
applies to AIFF files of sizes between 2GB and 4GB.

3.4 The QuickTime Movie format

Supports a variety of compression formats. When a multitrack document is saved as a QuickTime Movie
file, AmadeusPro will downmix it to a mono or stereo file, whichever is more suitable. Metadata is lost
when saving to the QuickTime Movie format.

Warning: At the moment, AmadeusPro does not keep video tracks in QuickTime movies. If you wish to
edit the sound track of a video clip, you should save the new sound track into a separate file and then use a
tool like iMovie to merge it back into the clip.

3.5 The NEXT/Sun format

A popular sound format on the Linux platform. AmadeusPro only supports NEXT/Sun files containing
uncompressed sound. It will downmix multitrack documents it to a mono or stereo file, whichever is more
suitable. Metadata is lost when saving to the NEXT/Sun format.
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3.6 The AAC ADTS, MPEG-4, and Bookmarkable AAC formats

These are different container formats that are primarily used to save data compressed with the lossy AAC
compression algorithm. AmadeusPro will downmix multitrack documents it to a mono or stereo file,
whichever is more suitable.

Metadata is lost when saving to the AAC ADTS format, but it is preserved when saving to the three other
formats.

Note that the AAC ADTS format is not the same as the Mp4 or Apple’s M4a format. These are three
different container formats and QuickTime for example will not be able to read AAC ADTS files. On the
other hand, the M4a and the Bookmarkable AAC format differ only in the file extension, but are treated
differently by iTunes and the iPod.

In most cases, you will probably wish to use the MPEG Audio (.m4a) format as this is the format used by
Apple’s iTunes Store.

3.7 The Apple CAF File format

This is a format developed by Apple and designed to replace AIFF in the long term. It removes the 2GB file
size limitation of AIFF and supports a wider variety of compression algorithms.

While the CAF file format does in principle support sound data with many channels, the current version of
AmadeusPro only supports the reading and writing of mono or stereo files in this format. AmadeusPro
will therefore downmix multitrack documents to a mono or stereo file, whichever is more suitable.

Metadata is lost when saving to the Apple CAF format (this may change in the future, as the format in
principle supports the inclusion of metadata).

3.8 The FLAC file format

FLAC (Free Lossless Audio Codec) is a compressed lossless sound format popular on the Linux platform.
It is possible to choose between different compression levels. Since the format is lossless, there is no
downside in principle to choosing the highest possible compression, but it may make file saving operations
significantly slower for a minor gain in file size.

When a multitrack document is saved as a FLAC file, AmadeusPro will downmix it to a mono or stereo
file, whichever is more suitable. Most text-based metadata is preserved in the FLAC file format, but artwork
is lost.

3.9 The Ogg Vorbis format

This is a popular alternative to the Mp3 format, expecially on the Linux platform. At intermediate bitrates
(128–256kbps), most listening tests favour Ogg Vorbis over Mp3 in terms of quality. From and end-user’s
perspective both formats are very similar in nature and most of what is said for the Mp3 format below also
applies to the Ogg Vorbis format. In particular, the settings are almost identical.

When a multitrack document is saved as an Ogg Vorbis file, AmadeusPro will downmix it to a mono or
stereo file, whichever is more suitable.
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Vorbis is the first of a planned family of Ogg multimedia coding formats being developed as part of
Xiphophorus’s Ogg multimedia project.

3.10 The Mp3 file format

This is an extremely popular lossy sound compression algorithm. AmadeusPro reads Mp3 (and also Mp2)
files through the tool mpg123 (see Section 15 below).

Saving Mp3 files is achieved through the tool lame. (See
also Section 15 below.) It supports a variety of settings
(the meaning of the most important one, the bitrate, was
explained above). In order to achieve a given file size, it is
recommended to use the ABR (Average Bit Rate – simple
parts of the sound will be compressed more than complex
parts, achieving a better overall quality) setting, rather than
CBR (Constant Bit Rate – all parts of the sound have the
same compression rate) in order to achieve maximum qual-
ity, but note that some Mp3 players may not support ABR
files. The VBR (Variable Bit Rate) setting is more flexible
and allows you to specify a target quality rather than a tar-
get file size. This usually results in better sounding files, but
you have less control over the resulting file size (‘complex’
sounds will produce larger files than ‘simple’ sounds for a given quality). Note also that as with ABR files,
not every Mp3 player supports VBR files. The screenshot next to this paragraph shows a popular setting
that represents a good trade-off between file size and sound quality. Note that the use of id3v2.4 tags is
discouraged since their support is broken in iTunes (this is true as of iTunes 7).

The Sample rate setting allows you to resample the sound before encoding. In most cases, the Automatic
setting will yield best results. For example, when encoding a 44.1kHz AIFF file at 32kbps, lame will
resample it to 16kHz. This will in general yield better result since less bandwidth is wasted on high-
frequencies and so the lower frequencies can be described more accurately. By changing this setting to
Original, this behaviour can be suppressed.

When a multitrack document is saved as an Mp3 file, AmadeusPro will downmix it to a mono or stereo
file, whichever is more suitable. Metadata (including artwork) is preserved in Mp3 files, provided that you
choose to create an id3v2 tag.

The remaining settings are mainly for expert usage. If you do not know what they mean, then you will
probably not need them.

3.11 The SoundDesigner format

This used to be a popular format on the Macintosh platform and it is still the format of choice for the software
Digital Performer. It can only contain uncompressed sound data, but has the advantage over AIFF and Wave
of not having a 2GB file size limitation.
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3.12 About raw data

AmadeusPro is able to import and export sound as raw sound data. Unless you are trying to recover data
from corrupt files or know precisely what you are doing, you are unlikely to need this functionality.

In particular, please do not use the Import Raw Data function to open normal sound files (AIFF, Wave,
Mp3, etc) unless you really do know what you are doing. Results are likely to range somewhere between
mild annoyances and total garbage.

If you are using the Import Raw Data function in order to recover data after a crash of AmadeusPro, you
should make sure that the Header size field is set to 0 and that the Samples Format field shows the correct
sample size, as well as the type of computer (Intel or PowerPC) that you are currently using.

3.13 Exporting markers

The Export Markers... function of the File menu allows you to export the markers of the currently open
document as a .cue file. This is a text-based file format that is commonly used by CD burning programs.
It has the advantage of being editable by any text editor, so that it is also possible to create your own .cue
files ‘by hand’. The Import Markers... function allows you to open .cue files and to add the corresponding
markers to the current document.

3.14 iTunes support

AmadeusPro plays nicely with iTunes. The File menu has an Export to iTunes library... item that allows
you to add the open document to your iTunes music library. It is recommended to set the metadata (song
name, artist name, etc) prior to selecting this function, so that the song shows up properly in iTunes.

Next to this, there is a Export as iPhone Ringtone... item that does pretty much the same thing, but instead
of adding the document to your music library, it adds it to your ringtone library. Both of these functions
were only tested with iTunes 8. They might not work correctly with earlier versions.

4 Sound recording and playback

4.1 Sound recording

The first step for any recording is of course to set your hardware up in such a way that the sound gets into
your computer. Most Macintosh models have a line-in audio input built in, so you can plug the output of
your Hi-Fi system directly into it (you will just need a standard mini-jack cable). If this is not the case for
your computer (check with your local Apple store if you are unsure about which one is the line-in plug) or
if you wish to obtain better control and / or better sound quality, you can use one of many third-party audio
devices. Any audio device compatible with MacOS X should be recognized correctly by AmadeusPro.
Popular brands include Griffin’s iMic, Motu, Roland / Edirol, Digidesign, etc. I am not affiliated with any of
these manufacturers and I can therefore not provide any advice on comparing their products or using them.

Once your hardware is set up, the easiest way of recording a sound with AmadeusPro is to click on
the red Record button depicted here. By default, this is exactly the same as choosing Record... in the
Sound menu. This will bring up a standard recording dialog and start the recording immediately. It is
possible to change this behaviour, see Section 10. Once your recording is complete, just hit Return
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or click the Stop button and the recorded sound will be inserted at the insertion point in the current track.
You can also have AmadeusPro create a new track containing the recorded sound by choosing the Record
to New Track... function instead. The function of the Record button can be customized by clicking on it
and leaving the mouse button pressed for half a second. This will show a pop-up menu that allows to choose
between the Record..., Record to New Track... and Record to New File... function. This choice will be
remembered next time the Record button is clicked.

The standard recording dialog only provides control over the volume of the recording. The volumes of
both channels (for a stereo recording) can be adjusted individually. Setting the Lock checkbox forces
AmadeusPro to use the same volume for both channels. Note however that AmadeusPro is able to provide
volume control only if your hardware allows it. Some sound recording devices do not provide any control
over the recording volume and in this case, the corresponding sliders will be grayed out. Please do not report
this behaviour, as it does not constitute a bug. AmadeusPro does intentionally not provide software volume
control at the time of recording since this can only diminish the resulting sound quality. If you are not able
to adjust the volume correctly in the recording window, you should make sure that your hardware is set up
properly.

One very common mistake is to plug a microphone directly into a line-in audio input. Without a preamplifier,
this will result in extremely low sound volume and poor sound quality. The iMic for example provides a
built-in preamplifier that can be controlled with a little black switch. A similarly common mistake is to plug
the line-out output of a home Hi-Fi system into a microphone input. This will result in a very saturated
sound. Both of these problems can only be solved by setting up the hardware properly and not by any
software solution. If you are unsure about how to connect your sound source to your computer, please seek
advice from your nearest Apple store or from the manufacturer of your audio input device.

Complete control over sound recording can be achieved by choosing Record to New File... in the Sound
menu. This brings up the following dialog:

The Record tab provides the same functionality as described above.

The Quality tab allows you to specify the sampling rate and sampling depth of the resulting sound. Clicking
on the Adjust button allows you to attempt to adjust the hardware quality to match the selected quality as
closely as possible. If it is not possible to match the selected quality exactly, AmadeusPro will automatically
convert the recorded sound to the selected quality. This tab also allows you to choose which channels to
record from. From the point of view of AmadeusPro’s recording function, every sound input device has
5 channels: front left, front right, back left, back right and center. Of course, your particular sound input
device may have more or (more likely) less input channels than that. It is therefore possible to assign the

Copyright c©2009 HairerSOFTHairerSOFT

http://en.wikipedia.org/wiki/Line-level
http://en.wikipedia.org/wiki/Preamplifier
http://en.wikipedia.org/wiki/Preamplifier


SOUND RECORDING AND PLAYBACK 17

physical channels of your input device to the 5 channels of AmadeusPro’s recording engine by clicking on
Advanced settings in the Input Source tab.

The File tab allows you to save a copy of the recorded sound while it is being recorded. This allows you, for
example, to record a radio show directly as an Mp3 file, therefore not having to spend a long time encoding
the recording once it is completed. Warning: If you select a configuration with more than two channels in
the Quality tab, only the first two channels will be saved to the file.

It is not necessary to use this function as a safeguard against the unlikely event of AmadeusPro crashing
during a recording: the recorded sound is always saved into a temporary file. This file will be placed in the
trash bin by AmadeusPro next time you launch the program and it can be recovered with the Import raw
data function.

The Timer tab allows you to schedule a recording for a predetermined time of the day. If you choose the
recording to start after a certain amount of time, you need to press the Record button in the Record tab to
launch the timer.

The recording window obeys to a number of handy key shortcuts that are summarised in the following table:

key action

space Starts / stops the recording
’M’ Creates a marker at the current location of the recording
’m’ Same as ’M’, but a dialog comes up, allowing to edit the marker
tab Same as ’M’.

4.2 Sound playback

Once a sound file has been opened in AmadeusPro, the most common task is to play it back. In a nutshell,
playback is controlled by the spacebar. Hit the spacebar to start it and hit it again to stop it. When no sound
is playing, hitting the tab key is equivalent to first hitting the rewind button and then hitting the space bar.
When a sound is playing, hitting the tabulation key is equivalent to first hitting the space bar and then hitting
the rewind button.

The current playback position is indicated by the playback head, which is displayed in the timescale
of the main document. The playback head is depicted on the right. The location of the playback head
can be changed by simply clicking at the corresponding location in the timescale. Whenever you click
in the main sound window and the sound is not being played back, the position of the playback head
is reset to the position selected in the General pane of the AmadeusPro preferences dialog. This position
would be either the start of the current selection or the start of the document. The precise behaviour of the
space bar is the following. If no sound is currently being played back, playback starts at the location of the
playback head. If a sound is being played back, playback stops. If Space bar rewinds sound is checked in
the General pane of the AmadeusPro preferences dialog, then the position of the playback head is reset,
otherwise it stays where it was when the space bar was hit.

More sophisticated control can be achieved through the playback controller:
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The Play icon has exactly the same functionality as hitting the spacebar. The Fast forward and Fast rewind
icons allow you to scrub through a sound while it is playing back. The Speed slider allows you to adjust the
playback speed. The scale is measured in semitones (12 semitones make up one octave) so that maximal
playback speed is double the original speed and minimal playback speed is half. The Volume slider allows
you to adjust the overall volume of the sound being played back.

4.3 Adjusting the playback device

The sound output device used for playback can be selected in the Sound preferences panel accessible by
choosing Preferences... in the Amadeus Pro menu.

Like the situation for recording, from the point of view of AmadeusPro’s playback function, every sound
input device has 5 ‘virtual’ channels: front left, front right, back left, back right and center. It is possible
to assign the physical channels of your input device to the 5 virtual channels by clicking on Advanced
settings in that preferences dialog. On a normal two-channel output device (built-in speakers for example)
the virtual center channel is assigned to the first available physical channel, which is usually the left speaker.
Therefore, a mono track set up to play back on the center channel has a good chance of being played back
through your left speaker. If you wish it to be played on both speakers simultaneously, you should select
front or back in the Playback menu of the track.

Note that by default, the output device used for playback is the one selected in the Sound system preferences
dialog. However, if you set a playback device using AmadeusPro’s preferences, this takes precedence over
any settings that you may have in the system preferences. The setting will also be remembered from one
session to the next.

5 Editing

5.1 Navigation

The first thing anyone would like to do when editing a file is of course to find one’s way around the file.
The two most obvious ways of navigating through a sound are the Horizontal zoom slider that allows you
to change the timescale and the horizontal scrollbar located just below the timescale.

However, there are many other ways to finding your way around a document. These are:

• The Markers palette already mentioned in the previous section.

• The ‘+’ and ‘-’ key shortcuts that allow to zoom in and out of the document.
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• The Zoom In / Zoom Out items in the toolbar (if they are not there and you happen to need them,
just choose Customize Toolbar in the View menu). There are corresponding menu items in the View
menu.

• The Zoom to Selection item in the View menu changes the display in such a way that the selected
portion of the current track just about fills up the display. If the selection is empty, the waveform is
expanded to the maximum (1sample = 1pixel) and it is moved in such a way that the insertion point
is located at the center of the display. The Zoom to Document item in the same menu has a similar
effect, but changes the zoom level so that the entire document neatly fits into the window.

• The scroll wheel of your mouse also allows you to zoom in and out of a document. If your mouse has
a horizontal scroll wheel as well (like Apple’s Mighty Mouse or the ‘two finger scrolling’ feature on
the trackpads of recent laptops) you can use it to move the document horizontally. There is a hidden
preference that allows you to exchange the behaviour of the horizontal and the vertical scroll wheel,
see Section 10.

• The Move to Selection and Move to Playback menu commands move the display (without changing
the timescale) in such a way that the center of the selection (or the playback head) is at the center of
the display.

• The keys ‘1’ to ‘4’ allow you to set the zoom level to one of four predefined values. You can set the
value corresponding to a key to the current zoom level by typing ‘Option-1’, ‘Option-2’, etc.

5.2 Basic editing

Most of the basic editing functions (Copy / Paste / Cut / Delete) work in exactly the same way as in any text
editor or image editor. The Delete in All Tracks function works like Delete but extends its action to all the
tracks of the document instead of just the currently selected one.

The Paste Over function allows you to literally paste the content of the clipboard over the current sound,
effectively mixing it with the document instead of just inserting it at the insertion point.

Another useful feature of AmadeusPro is that tracks can be shuffled around using drag and drop, by clicking
into the shaded grey track header. In particular, they can be moved from one document to another. If the
sampling rate and / or sampling depth of the dragged track does not match that of the receiving document,
it will be converted accordingly.

The Extend to Crossing function in the Selection menu allows you to extend the current selection to the
nearest points where the waveform crosses the 0-line. This is probably best illustrated by the following two
screenshots, where the left hand side shows the selection of a sound before applying this function and the
right hand side shows the same sound after applying the Extend to Crossing function.

This is very useful in order to avoid little crackling noises at the points where sounds are cut and pasted.
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5.2.1 Inserting silence

To insert a silent portion of a given length, use the Generate Silence... function from the Effects menu.
To silence a portion of a sound, first select the portion you wish to silence and then choose Amplify from
the Effects menu, with a setting of 0%. (Make sure that % is selected and not dB!) This has the advantage
that you can optionally choose a short fading, which will make for a smooth transition to the silent portion
instead of an abrupt transition which may sound like a crack.

5.2.2 Changing the characteristics of a sound

The characteristics (sampling rate and bit depth) of a sound can be changed by choosing Characteristics...
in the Sound menu. If the “don’t resample” checkbox in that dialog is checked, the current sound will
simply be played back at a different speed, without changing the actual sound samples.

For example, if you change the sampling rate from 44.1kHz to 22.05kHz and have “don’t resample”
checked, the sound will be played back at half speed (so its pitch will also be lowered by one octave).
If the “don’t resample” option is left unchecked, then half of the sound samples will be thrown away, so that
playing back the sound at half speed results in something sounding roughly identical (except for a loss in
the high frequencies) to the original.

5.3 Applying effects to a sound

AmadeusPro ships with a number of sound effects covering most needs, but its capabilities can be greatly
extended by the addition of third-party effects. AmadeusPro supports effects in both Steinberg’s VST and
Apple’s Audio Unit format. However, Audio Units are preferred over VST effects. The support for VST
effects is frozen at the current state whereas Audio Unit support is expected to improve in future versions of
AmadeusPro.

Several Audio Units are shipped by Apple with MacOS X and should show up in the Audio Units submenu
without having to take any action. Installing a third-party effect is as simple as dragging the correspond-
ing file into the appropriate subfolder (Components for Audio Units and VST for VST effects) of your
‘Library/Audio/Plug-Ins’ folder. A collection of third-party Audio Units can be downloaded here.

In order to apply a sound effect to a portion of a sound, select this portion first and then select the desired
sound effect. In order to apply an effect to the whole track, you can either leave its selection empty or select
the whole track with the Select All function from the Edit menu.

The remainder of this subsection is devoted to the description of the content of the Effects menu. The
description of the Interpolate and Denoising items is however postponed to Section 8.

5.3.1 Echo

Applies a simple echo to the sound (this effect is also called ‘Delay’ by some audio programs). The gain
setting describes the intensity of the echo, it should always be a negative amount in dB or a percentage less
than 100%. The delay setting gives the delay of the echo, which is the amount of time after which the sound
is repeated. The further setting, when the corresponding checkbox is ticked, allows to extend the echo
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further than the selection. To appreciate its effect, try selecting a drumbeat and apply an echo with a delay
of 0.2 seconds, a gain of 60% and the further setting set to 2 seconds.

5.3.2 Amplify

Allows to amplify (or decrease) the volume of the selection by a given amount. See the box on page ?? for
a discussion of the meaning of the dB and % units. The Fading function allows to make a smooth transition
to the selected volume at the start and end of the selection.

5.3.3 Equalizers

The Equalizers submenu contains three standard multi-band equalizers (they work in exactly the same way
as the graphic equalizers on your hifi equipment), as well as a collection of specialized equalizers aimed at
the restoration of old vinyl recordings. These specialized equalizers are described in this section.

The RIAA Reproduction filter allows you to compensate for the standard RIAA filter usually applied on
vinyl recordings. See for example http://www.bonavolta.ch/hobby/en/audio/riaa.htm for more information.
In general, vinyl recordings are engraved with reduced bass levels and increased treble levels. In 1954, the
RIAA (Recording Industry Association of America) introduced a standard filter that was used on nearly all
phonograph recordings since then. The RIAA Reproduction filter allows you to apply the RIAA curve to
a recording. This is usually done by the turntable preamplifier. It may however be useful if you connect a
turntable directly to your computer or use a normal preamplifier.

The Inverse RIAA Reproduction filter applies the inverse of the RIAA curve to a recording. This is useful
for undoing the effect of a turntable preamplifier on acoustic LP recordings that were not engraved with the
RIAA curve.

The RIAA/IEC Reproduction and Inverse RIAA/IEC Reproduction filters work in a similar way, except
that they use a modification of the original RIAA curve that was introduced around 1976 but is not as
widespread.

The LP / 78rpm Equalizer is a parametric equalizer that is designed to allow the reproduction of old vinyl
recordings. It contains a number of presets for leading manufacturers. More information can be found for
example at

http://www.hal-pc.org/˜clement/Restoring%20Old%20Recordings.htm#Appendix B

If the recording is made through a standard turntable preamplifier, RIAA de-emphasis should be enabled
in order to compensate for the RIAA curve.

5.3.4 Fadings

The Fadings menu contains various functions that allow to change the volume of a sound. The fading
curves used by the Fade in and Fade out functions can be selected in the palette that opens when selecting
the Settings... menu item.
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The Symmetric fade function is equivalent to first applying a Fade in to a portion of the desired length at
the beginning of the selection, followed by applying a Fade out to a portion of the same length at the end
of the selection.

The Ramp function allows to change the volume of the sound from one level at the start of the selection to
another level at the end of the selection.

The Crossfade to the Left and Crossfade to the Right functions allow you to easily create a transition
between two pieces of sound. This is how it works. Let’s say you want to produce a file containing the
songs ‘Song A’ and ‘Song B’. Copy them one behind the other into your file and place a marker at the
junction of both songs. Then select, say 1 second of ‘Song B’ starting from the marker and select Crossfade
to the Left. This will first create a fade in of 1 second at the beginning of ‘Song B’ and a fade out of 1
second at the end of ‘Song A’. It will then merge these two parts into one, creating a nice transition. The
Crossfade to the Right produces the same result if you select 1 second at the end of ‘Song A’.

The Loop Crossfade function is similar to what was just described, except that it creates a transition between
the end and the start of the selection. This allows the resulting sound to be looped seamlessly.

5.3.5 Normalizing a sound

A commonly performed task is to bring the level of a recording to some standard volume level. This can
be performed through the Normalize... command. A problem with this is the notion of ‘level’, as there
are many different ways of measuring a sound’s level. The Normalize... function supports two notions of
sound level. The maximal sample value simply looks for the sample that has the largest absolute value and
then amplifies the whole sound in such a way that this sample is brought to the reference level. This has the
advantage that if the level is chosen to be smaller than 0dB, it is guaranteed that no clipping will occur. The
disadvantage is that a short outburst of unusual loudness or a crackle in the sound will dominate the picture,
so that the achieved effect is not always what was intended.

The maximal RMS power setting tries to compensate for this by taking average levels over relatively
short time intervals (100ms) and choosing the largest of these average levels as the reference. This has the
advantage of being usually closer to the desired effect. However, it does not guarantee that no clipping will
occur. Normalizing the RMS power to around −10dB or −15dB is quite safe in most situations.

Note that the Normalize... function adjusts the global volume of the sound, but does not compensate for
variations of volume within a recording. If you wish to obtain several songs sounding very homogeneous
throughout (as required for example for background music in a store), you may want to apply dynamical
compression before normalizing. One sequence of steps that works well for most situations is to first apply
Apple’s AUDynamicsProcessor Audio Unit with the ‘hard’ factory preset and then to normalize the RMS
power to 25%.

5.3.6 Reverse

This effect reverses the time on the selection, thus playing it backwards.
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5.3.7 Audio Units

As explained above, Audio Units are plug-ins developed by third parties that allow to extend AmadeusPro’s
(and any other Audio Units host’s) abilities. The Audio Units Rack allows to apply several Audio Units
in one go. Simply drag the desired effects from the Available Audio Units section to the Applied Audio
Units section of the rack window. In order to change the settings of an effect, either double-click on it or
select it and click on the button with the little pen. You can remove an effect from the list of applied Audio
Units by selecting it and hitting the ‘backspace’ key or clicking on the button with the minus sign.

The following list of effects ship with MacOS X 10.4. Unfortunately, Apple doesn’t ship any documentation
whatsoever for their settings so your bet is as good as anyone’s. For some of the more esoteric settings,
experimenting is probably the best option.

• AUBandpass Suppresses all frequencies outside of a specified band.

• AUDelay Same as the Echo effect. It includes a dry/wet mix setting that allows to choose the propor-
tion between the original sound and the echo. At 0%, it makes no modification to the sound, at 100%
it keeps only the echo and removes the original sound. The default value of 50% corresponds to the
behaviour of AmadeusPro’s Echo effect.

• AUDynamicsProcessor This allows to expand or compress the dynamical range of a sound. The
dynamical range is the ratio in volume between the quiet parts and the loud parts. Compressing
the dynamical range results in the volume becoming more uniform throughout the sound. When
normalized afterwards, the quieter parts will therefore sound louder. This effect is often used (and
abused) by record labels in order to make a CD sound louder. The different presets shipping with this
effect give good results.

• AUFilter This is basically a combination of an AUHipass and an AULowpass filter, as well as three
parametric equalizers.

• AUGraphicEQ Standard 10 or 30-band graphical equalizer.

• AUHighShelfFilter Reduces drastically frequencies below a cut-off frequency. The gain setting al-
lows to adjust the strength of this reduction.

• AULowShelfFilter The opposite of AUHighShelfFilter, it reduces drastically frequencies above a
cut-off frequency. The gain setting allows again to adjust the strength of this reduction. Useful to
remove a low rumble in a recording.

• AUHipass Pretty much the same as AULowShelfFilter.

• AULowPass Pretty much the same as AUHighShelfFilter.

• AUMatrixReverb Very sophisticated reverb effect. It takes stereo effects into account to create the
impression of a large enclosed space and can therefore not be applied on mono tracks. You will
probably want at least to lower the dry/wet mix to 50% from its default value of 100%.

• AUMultibandCompressor A compressor (like the AUDynamicsProcessor effect) that however first
divides the sound into four separate frequency bands, determined by the ‘crossover frequencies’. It
then allows to have different settings for each of the four frequency bands.
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• AUNetSend Allows to send the sound over a network. It doesn’t perform any processing and is
therefore only useful in Preview mode.

• AUParametricEQ Allows to boost or decrease the volume in a frequency band centred around the
‘center frequency’. The ‘Q’ value determines the width of the frequency band.

• AUPeakLimiter Amplifies the sound by ‘pre-gain’, but makes sure that it does not get clipped. Works
essentially like a compressor.

• AUPitch Allows to change the pitch of a sound without changing its speed. The change in pitch
is given in ‘cents’. There are 100 cents in a semitone and therefore 1200 cents in one octave. The
remaining parameters allow to fine-tune the effect.

• AUSampleDelay Simply shifts the sound forward by the specified number of samples. Probably
useless in AmadeusPro’s context of off-line processing.

5.3.8 Change Pitch and Speed

This effect allows you to change the pitch and the speed of a sound independently. It is very useful for
example to constrain a recording to a certain length. The algorithm used is Apple’s AUPitch Audio Unit,
which provides professional quality even though it is included with every copy of MacOS X.

Increasing the quality results in a deterioration of processing speed and vice-versa. The adjustment of the
pitch is done in semitones, i.e. +12 corresponds to increasing the pitch by one octave and -12 to decreasing
it by one octave. If lock is selected, the speed increase/decrease exactly matches the pitch increase/decrease
in such a way that the result is the same as what would be obtained by just playing the sound back at a
different speed. In that case, the sound is simply resampled and does not go through the AUPitch effect.

5.3.9 Stereo Utilities

These are a couple of utilities useful for processing stereo sound. The Balance function allows to adjust
the balance between the left and right channel and the Swap channels function allows to swap the left and
the right channel. The Invert phase function changes the sign of the waveform. This is useful in order to
reduce the amplitude of the ‘center’ in a stereo recording, which is how many ‘Karaoke’ effects work. In
order to apply a ‘Karaoke’ effect to a stereo recording, you can:

• Select Split track in the Sound menu.

• Select the whole first track and apply the Invert phase effect.

• Select Merge with Next Track in the Sound menu.

• Select Convert Track to Mono in the Sound menu.

5.3.10 VST Effects

VST plug-ins work very much like Audio Units and an effort has been made to present coherent interfaces
for both types of plug-ins. The VST Rack therefore works in exactly the same way as the Audio Units
Rack.
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One commonly encountered problem is that many VST plug-ins have not been ported to Intel yet and only
run on PowerPC computers. If this is the case, an error message will be presented. An archive with some
free VST plug-ins that however work only on PowerPC computers can be found here.

5.4 Maintaining a list of commonly used actions

The first item of the Effects menu allows you to perform again the most recently performed action. The
Actions tool accessible from the Windows menu maintains a list of the five most recently performed actions.
It also allows you to save some favourite actions by simply dragging them from the Last actions list into
the Favorite actions list. Favorite actions can be given any name by option-clicking on them. They can
be deleted by moving them into the little trash bin in the lower right corner of the window. The Clear last
actions button allows you to clear the list of last actions. It also clears the state of the first item of the Effects
menu.

5.5 Working with presets

Most of the functions in AmadeusPro do not only remember their
last settings, but allow you to maintain a list of presets which
would typically be commonly used settings. For example, the
window managing the 3-band equalizer is represented in the right
margin.

The Presets menu contains the list of presets with the name of the
currently used preset being displayed inside the menu button. If
these don’t match any of the presets or if no preset exists, Not a
Preset is displayed instead.

When you select Save Preset..., a dialog allows you to choose the
name of the new preset, which will then be a copy of the current preset. The Edit Presets... function allows
to manage the list of presets. In particular, it allows you to rename, to duplicate, and to delete them. Some
(but by no means all) functions do have a default set of presets built into AmadeusPro. If this is the case,
the presets menu also contains a Revert to Defaults... item which allows you to revert to the factory defaults
in case you destroyed them by inadvertance. Warning: Your own presets will be lost in this case.

6 Batch processing

AmadeusPro includes a powerful batch processing engine. A new batch processor can be created by choos-
ing New Batch Processor in the File menu. A batch processor allows you to not only convert files from one
file format to another, but it also allows you to apply various effects (normalizing, fadings, etc). An example
of a batch processor that converts AIFF files into Mp3 files could look like this:
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The Change Name To field allows you to specify a name for the resulting file. The special sequence of
characters ‘%name’ will be replaced by the name of the currently processed file. Other usable special
sequences of characters are %title, %artist, %album and %year. These correspond to the contents of the
corresponding metadata fields. However, note that these fields can be empty if the sound being processes
contains no metadata.

The Filter Files setting allows you to enter a regular expression against which filenames will be checked.
Only files with matching filenames will be processed. Explaining in detail what regular expressions are goes
beyond the scope of this manual. Information about the type of regular expressions used by AmadeusPro
can be found at the following link:

http://icu.sourceforge.net/userguide/regexp.html

Examples of valid regular expressions are

.*\.mp[2-4] Matches any filename ending in ‘.mp2’, ‘.mp3’ or ‘.mp4’.
Track.* Matches any filename starting with ‘Track’.

A file or a collection of files is processed by the batch processor by dragging the file(s) onto the indicated
area. If a folder is dragged to this area, only the files at the first level within the folder are processed by
default, unless you check the Open subfolders recursively option, in which case the whole folder hierarchy
is processed.

The Actions tab allows you to choose an arbitrary number of sound effects to be applied to the sound being
processed. These effects are applied to the sound in the order in which they appear in the list. They are
the same as the ones appearing in the Effects menu, except for a few items that allow to manipulate the
current selection of the sound, as well as the sound quality. Suppose for example that you wish to create a
20 seconds summary in the Mp3 format for a collection of audio tracks. In order to achieve this, you would
create a batch processor with the following settings:

1. In the Format section, select ‘Mp3’ as your resulting format and select the appropriate settings (see
Section 3).

2. Check the Change Name To: checkbox and enter ‘%name-summary’ as your filename.

Copyright c©2009 HairerSOFTHairerSOFT

http://icu.sourceforge.net/userguide/regexp.html


MANAGING TRACKS 27

3. In the Actions section, add one Set Selection... action and choose 30 seconds from the start in the
dialog that will appear. Then, add a Delete Selection action, followed by another Set Selection...
action with this time 20 seconds from the start and a Crop Selection action. This leaves us with a 20
seconds piece of sound located 30 seconds into the original sound. We then add 1 second fade in and
outs, follwed by a normalisation. This should leave you with the actions section looking like on the
following screenshot:

It now suffices to drag your collection of files onto the area at the bottom of the batch processing
window and sit back to watch AmadeusPro do all the hard work for you.

The Metadata tab allows you to change the metadata of the sound being processed. This allows you, for
example, to convert all the tracks from a CD to Mp3 and simultaneously set the artist and album names to
the correct values. The special sequences of characters mentioned above can be used in any of the metadata
text fields. So you can for example enter ‘%title - %track’ in the Title field in order to change a name like
‘Wish you were here’ to something like ‘Wish you were here - 3’.

7 Managing tracks

As we already saw in Section 2.4, an AmadeusPro document can consist of several tracks and each of them
can be either mono or stereo. We have already seen in Section 5 how to edit the content of individual tracks.
This section shows how to edit a document at the track level.

7.1 Moving and reordering tracks

Tracks do not have to start at time 0 but can be moved to an arbitrary starting time. To do so, just click
on one of the small handles located at either end of the track (see the screenshot to the right) and drag
it to the desired location. However, there always has to be at least one track starting at 0, so that the
handles are greyed out if moving them would break this rule.

The order of tracks can also be changed and tracks can even be moved from one document to another one.
To do so, click into the shaded gray area located at the top of the track and drag the mouse to the desired
location. This location can also be within a different document.

7.2 Creating and deleting tracks

The items of the toolbar showed to the right allow to manage tracks. The first one
creates a new track with the same characteristics as the current track. This can also be
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achieved with either the Add New Mono Track item or the Add New Stereo Track item in the Sound
menu. The second toolbar item deletes the current track, which can also be done via the Delete Track menu
item. The third toolbar item allows to split a stereo track into two mono tracks, one for each channel. This
corresponds to the Split Track menu item. It is very useful in situations where the two channels of a stereo
track really correspond to two completely different parts of a recording (like the vocals and the background
music or the two participants in a Skype conversation) and should be edited separately. The Merge With
Next Track menu item is the opposite of the Split Track function and allows to combine two mono tracks
into one stereo track.

Most track-related functions described above can also be accessed by right-clicking (control-clicking on a
one-button mouse) into the shaded gray area at the top of a given track.

8 Sound Restoration

One of the strengths of AmadeusPro is that it provides you at low cost with two tools to restore damaged
recordings that are of a quality that rivals that of professional products. These two tools have two very
different purposes: either the elimination of very short and precise cracks and pops or the elimination of a
continuous background noise.

8.1 Elimination of pops and cracks

A common problem of old vinyl recordings are the pops and cracks that are caused by scratches in the disk.
Provided that they are isolated and that there are not too many of them, such cracks can be eliminated in a
very efficient way by AmadeusPro.

In order to eliminate a single isolated crack, proceed as follows. First, find the location of the crack in your
sound and zoom into it. A crack can usually be spotted visually as a spike in the waveform. Then, select
the entire crack and choose Interpolate in the Effects menu. Alternatively, you can also just hit the ‘r’ key.
Make sure that you select a piece of sound that is as short as possible. Ideally, you want to select only one
isolated crack and nothing else. If a too long piece of sound is selected, AmadeusPro will complain and
refuse to apply this function.

If a sound contains many cracks, and in order to have more control
over the repairing, you can use the Repair Centre tool accessi-
ble from the Windows menu. This shows a zoomed display of
the waveform of the current track. One convenient feature of this
display is that it is always scaled vertically in such a way that the
whole height of the display is being used. This allows you to see
the waveform accurately even if it has a low amplitude. The small
blue knob at the top of the display allows you to scroll through
the waveform, the position of the knob determines the speed of
the scrolling. If a location in the waveform looking like a crack is
found, you can determine whether it really is a crack in the follow-
ing way. First click on Preview original which plays a short section of sound (about one second) containing
the current selection. If this section contains a crack, click on Preview repaired which plays exactly the
same section, but with the selected portion repaired. If this provides a satisfactory result, click on Repair
in order to apply the repair to the sound. If it doesn’t produce any audible improvement, it may be possible
that the real crack is located slightly after or before the current location.
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The Find next function looks for the first crack following the current location. This function may return
false positives (locations that look like cracks to AmadeusPro but that are in fact not), so you should always
manually verify any crack found using this function.

The repair centre window obeys to a number of handy key shortcuts that are summarised in the following
table:

key action

r Repairs the current selection
shift-r Repairs the current selection and finds the next crack

t Repairs the top channel of the current selection
shift-t Repairs the top channel of the current selection and finds the next crack

b Repairs the bottom channel of the current selection
shift-b Repairs the bottom channel of the current selection and finds the next crack

o Preview original sound
p Preview repaired sound
n Finds the next crack
z Undoes the last action

shift-z Redoes the last action

The basic sound repair functions are also available with simple key shortcuts from the main sound window,
even if the

8.2 Elimination of a continuous background noise

Another common problem is the presence of a continuous background noise on a recording. One example is
the background hiss on a recording coming from a magnetic tape. Another example is the 50Hz or 60Hz hum
coming from the electric grid. (This is commonly picked up by microphones that are somehow connected
to a device that runs on a power supply and not on battery.)

Warning: However good a software package is, it cannot resurrect what is lost. You should therefore
always try first to get the best possible quality by choosing appropriate recording equipment and only use
software-based restoration functions as a matter of last resort. If a recording is important to you and cannot
be repeated, try to make tests in similar conditions first.

The Denoising function in the Effects menu provides a very efficient algorithm for suppressing background
noise. The easiest way to use it is the following:

• Select a piece of your sound containing only noise.
• Select the menu item Sample noise. The plugin will scan the selected noise and construct a noise

profile.
• Select the whole piece of sound.
• Select the menu item Suppress noise. This will remove the background noise from the selected part of

the sound, according to the noise profile constructed previously.

Sometimes, there is no piece of sound containing only noise available. In this case, you may want use
the Suppress White Noise function. The easiest way to proceed is to use the Preview function to play
the selected sound and then to adjust the Noise RMS power with the slider provided until the result is
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satisfactory. Note that choosing too large a value of the Noise RMS power will result in a significant loss of
quality in the clean signal, whereas choosing a too small value will leave some background hiss remaining.

It may happen sometimes that the background noise one wishes to remove is very well localised in frequency
(like the case of the hum discussed above). In this case, it is advisable to use the Suppress Frequency
Band... function to remove every frequency localised between the Lower Frequency and the Upper Fre-
quency.

Finally, the Suppress DC Offset function allows you to remove a low-frequency drift in the microphone
(this happens for example on the integrated microphone of some of the older PowerBook models).

The Denoising function is customizeable with the Settings... menu item. The Noise Type allows you to
choose the type of noise you want to remove. Choosing a peaked noise is suited for background noise which
is very well localised in frequency space. A typical example is the removal of the 50Hz or 60Hz humming
produced by the power supply. The smooth noise function is adapted to the removal of noise that is spread
over the whole frequency range, like for example a tape hiss. If the Adaptive Filtering option is disabled,
the program will compute one global filter and apply this filter to the whole sound. This sometimes yields
better results when the signal-to-noise ratio is very low. The Sensitivity Enhancement option tells the
program the amount of background noise to remove. Usually, values between 30% and 70% yield the best
results. For lower values, some background noise may remain after the application of the filter. For higher
values, the signal may be substantially altered.

The Algorithm pop-up menu allows you to choose which algorithm should be used for the denoising.
Currently, two algorithms are available: Short FFT and Long FFT. Generally, the Long FFT algorithm
produces better results, but the Short FFT algorithm is slightly faster.

9 Key shortcuts

First of all, note that it is possible to change the key shortcuts for menu items in the Keyboard Shortcuts
section of the Keyboard & Mouse system preferences pane. This is an extremely useful feature that is often
overlooked by people and works in every application on MacOS X.

Here is a list of the key shortcuts that can be used in the main sound window of AmadeusPro:
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key action

space bar Starts sound playback
command-space bar Starts playback of the current track only

tab key Rewinds and then starts playback
option 1-4 Stores the current zoom level into the corresponding register

1-4 Sets the current zoom level the value stored in the corresponding register
e Previews the effect of deleting the current selection
a Extends the selection by one pixel to the left
s Shrinks the selection by one pixel at the left
d Shrinks the selection by one pixel at the right
f Extends the selection by one pixel to the right
g Toggles the display of the grid behind the waveform
h Toggles the display of the selection in the timescale
n Cycles the currently active track between all the tracks of the document

m Creates a marker at the insertion point
r Repairs the selection (select only a very short piece)
t Repairs the top channel of the selection (select only a very short piece)
b Repairs the bottom channel of the selection (select only a very short piece)
p Creates a marker at the playback head

down arrow Plays back half an octave lower
up arrow Plays back half an octave higher

left arrow Places the insertion point at the left end of the selection
right arrow Places the insertion point at the right end of the selection

[ Places the insertion point at the left end of the selection. If nothing is
selected, moves the insertion point to the left by one pixel.

] Places the insertion point at the right end of the selection. If nothing is
selected, moves the insertion point to the right by one pixel.

option-left arrow Moves insertion point to the previous marker
option-right arrow Moves insertion point to the next marker

command-left arrow Extends the selection to the previous marker
command-right arrow Extends the selection to the next marker

home Jumps to the beginning of the sound
end Jumps to the end of the sound

page up Moves to the left by one screen
page down Moves to the right by one screen

+ or = Zooms deeper into the sound
- Zooms out of the sound

option-‘+ or =’ Zooms vertically into the sound
option-‘-’ Zooms vertically out of the sound

command-click Places a marker at the clicked point
shift-click Extends / shrinks the selection to the clicked point

double-click Starts playing the current track from the clicked point

10 Hidden preferences

There are a few preference settings that cannot be accessed from the user interface. They can be set from
the Terminal.app application by typing a command like

Copyright c©2009 HairerSOFTHairerSOFT



SOUND ANALYSIS TOOLS 32

defaults write com.HairerSoft.AmadeusPro HSMySetting value

where HSMySetting is the name of the setting in question and value is the value to which you wish to
set it. The list of hidden settings is given in the following table, where the Default column shows the value
corresponding to AmadeusPro’s default behaviour.

Name Meaning Default

HSInvertScrollingBehaviour A value of 1 tells AmadeusPro to use the scroll wheel to
control navigation rather than the zoom level.

0

HSNumberHarmonics Number of harmonics displayed in the spectrum analysis
window.

5

HSSelectionToMarker If equal to 1, moves the insertion point to a marker newly
created by clicking into the markers list.

1

HSWindowOffset Default distance (in pixels) between the main document
window and the left edge of the screen.

20

HSNameTracks If equal to 1, automatically adds a “Name” and a “Track”
tag to files created using the Split according to markers
function.

0

HSCreateIndexPoints If equal to 1, index points are created at markers not used
to delimit tracks when burning a CD. For example, if black
markers are used to delimit tracks, then all markers that are
not black will be interpreted as index points. Note: Not all
CD players support index points.

0

11 Sound analysis tools

AmadeusPro comes with a number of high quality sound analysis tools. They fall into three categories:
graphical analysis tools (sonogram and spectrum analysis), non-graphical tools (waveform statistics and find
maximum), and real-time analysis tools (multi-band RTA, real-time spectrum, oscilloscope).

Most real-time analysis tools can be used in full-screen mode. To enter full-screen mode, choose Full
Screen in the View menu or type command-L. To exit full-screen mode, type any key except for the space
bar. The space bar instead pauses the tool.

Note that full-screen mode is not available for sound editing.

11.1 Spectrum

This is the most basic and common graphical analysis tool. It relies on the fact, known since the work of
the French mathematician Joseph Fourier (1768–1830), that any periodic signal of a given frequency can be
decomposed into a sum of ‘pure’ (or sinusoidal) signals whose frequencies are multiples of the frequency
of the original signal. For example, the following picture shows the signal from page 5, as well as the two
sinusoidal signals (blue and red lines) into which it can be decomposed.
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The Spectrum tool takes a piece of signal of a certain length T (the length in question is equal to twice the
number, in samples, selected in the Size field of the dialog that comes up when you choose Spectrum) and
decomposes it into a superposition of sine waves of periods T , T/2, T/3, etc as explained above. It then
represents the amplitudes of these pure sine waves as a function of their frequencies.

The location of the piece of signal in question relative to the current selection can be chosen in the Spec-
trum location field. At this stage, you may wonder about the fact that the period T chosen for the spectrum
analysis is just a fixed number chosen by the user (like 4096 samples for example), which does not neces-
sarily correspond to the period of the signal that is being analyzed. Furthermore, it may well happen that
the signal in question is just not periodic at all. What AmadeusPro (and just about any other analysis tool)
does is to consider the periodic continuation of the signal. In other words, it just pretends that the signal is
periodic of the given period, even though this is probably not the case. Let us see what this means for our
favourite signal (still the one from page 5). The following figure shows that signal in black, and it has an
interval marked as coresponding to the period T which has nothing to do with the true period of the signal.

T

The blue line then shows to the periodic continuation of the signal according to the marked interval. Note
that this line is discontinuous, i.e. it has a ‘jump’ at the endpoints of the marked interval. It is intuitively
clear that this discontinuity is not a desirable feature. One way of getting rid of it is to multiply the signal
by a windowing function which is close to one inside the marked interval and goes to zero at its endpoints.
The red line in the above figure shows the periodic continuation of the ‘windowed’ signal. It does no longer
present a discontinuity but of course it does no longer perfectly match the original signal inside the marked
interval. Such a windowing function can be selected in the Windowing function field when you make a
spectrum analysis.

A list of the most popular windowing functions can be found at this Wikipedia page.

The spectrum analysis window has several features that facilitate its reading. The Current location text field
in the toolbar shows the frequency / intensity corresponding to the current location of the mouse. Intensities
are given in decibels. The Nearest note text field shows the note (on a standard tempered scale with A4
at 440Hz) which is nearest to the frequency corresponding to the current location of the mouse. The exact
frequency corresponding to that note is shown in brackets.

In order to facilitate the reading, a thin green line is drawn at the current location of the mouse. Further-
more, the harmonics (i.e. multiples) of the corresponding frequency are also shown as green lines. The
reason why harmonics are important is because a note played on a musical instrument does not consist of a
single frequency but of a fundamental frequency and all its multiples, or harmonics. The ratios between the
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intensities of the harmonics determine the ‘color’ of the sound and allow us to distinguish between different
musical instruments. The number of harmonics that are displayed is 5 by default, but can be changed by a
hidden preference, see Section 10.

The scale of the display can be changed by clicking on the Settings icon in the toolbar.

A spectrum analysis can be exported as a text file for processing in another program by choosing Save A
Copy As... in the File menu. This creates a file with three columns. The first column contains the frequency
of a given component, the second and third contain its amplitude in complex notation. (So the intensity of
a component is the sum of the squares of the real and the imaginary part.) If the spectrum was created by
choosing Average over selection, then all the imaginary parts are 0.

11.2 Sonogram

A sonogram (also called spectrogram) is a two-dimensional graphical representation of a sound. An example
of a sonogram is shown below:

The bottom part of the window contains a waveform representation of the sound, just like in the main
document window. The top part represents the frequency as a function of time, with intensities shown with
a color scale. With the scale chosen for this picture, the white and yellow parts are of low intensity whereas
the red and blue parts are of high intensity.

Basically, each vertical ‘slice’ of a sonogram corresponds to a spectrum analysis as described in the previ-
ous section, except that intensities are displayed with a color scale. When hovering over a sonogram, the
frequency (and nearest note in brackets) corresponding to the current location of the mouse is displayed in
the lower left corner of the window. A sonogram window can be navigated in pretty much the same way as
a sound document window. Most of the same key shortcuts work in both windows. The Color palette menu
of the toolbar allows you to choose between different color scales, as well as to edit them.

The Range and Gain sliders in the toolbar allow to adjust the color scale. Its effect is probably best explained
by an example. Let’s say that one chooses the Grayscales color palette which draws areas of low intensity
in white and areas of high intensity in black. Then, if Range is set to 60 and Gain is set to 15, every intensity
above −15dB will be drawn in black and every intensity below −75dB (75 = 60 + 10) is drawn in white.
Intensities falling between these two extreme values will be drawn in shades of gray.

Clicking on the Settings icon in the toolbar shows the following dialog:
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The Image size field allows you to choose the height of the sonogram in pixels and the Resolution field
allows you to choose its resolution. This latter setting is only used when printing or when exporting the
sonogram to an image file. The Frequ. scale field allows you to switch between a linear and a logarithmic
scale for frequencies. In a linear scale, the distance between successive harmonics of a given frequency is
constant, whereas in a logarithmic scale it is the distance between successive octaves which is constant. The
Pixels / semitone setting is only relevant if the frequency scale is chosen to be logarithmic. It allows you
to set the distance (in pixels) between two successive semitones on the sonogram. Note that there are 12
semitones in an octave, so that if this value is for example set to 10, then two successive octaves will be 120
pixels apart.

The Max. Frequ. setting allows you to change the maximum frequency displayed in the sonogram. This
is always a subharmonic of the sampling rate. The FFT size and Window settings have exactly the same
meanings as the Size and Window settings for the Spectrum function. Note that the FFT size value does
not necessarily need to match the Image size value. Larger values tend to give a ‘crisper’ picture, whereas
lower values will give a more blurred picture. It is usually a good idea to use some windowing in order to
get a nice sonogram representation of a sound.

Sonograms can be exported as pictures in various formats by choosing Save A Copy As... in the File menu.
They can also be saved in a format proper to AmadeusPro by choosing Save in the File menu. Note that
this format is not compatible with sonogram files created by Amadeus II.

11.3 Waveform Statistics

As its name suggests, this function allows you to collect various statistics on the selected sound. The various
RMS Power values are calculated by computing the RMS power over intervals of length RMS window. The
DC Offset value represents the average value of the waveform. It is usually desirable that this value is low.
If it is larger than about 0.01 over an interval of more than one second, you may want to use the Suppress
DC Offset function in the Effects⇒ Denoising menu.

Clipped samples are samples that take the maximal admissible value. The presence of clipping indicates
that the volume of the sound is too high. This usually results in a ‘saturated’ sound that is very unpleasant.
Unfortunately, it is not possible to significantly improve the quality of the sound once clipping has occured.
If you find that a recorded sound contains clipped samples, it is advisable to perform the recording again
with the input gain set to a lower value.

The Average RMS power is a useful indication of how ‘loud’ a song sounds on average. If you have two
songs with one of them showing an average RMS power of −20dB and the other one showing a value of
−30dB, the second song will sound significantly quieter than the first one. In order to bring it to roughly the
same level, you can amplify it by 10dB. See also Section 5.3.5 for some tips on how to normalize sounds to
bring them approximately to the same level.
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Hitting command-C while the waveform statistics are displayed copies them into the clipboard, so that they
can be reused for example in a spreadsheet program like OpenOffice.

11.4 Find Maximum / Find Next Clipped Sample

This function allows you to find the largest sample in the current selection. If the selection is empty, it will
find the next clipped sample, starting from the location of the insertion point. Once the search is complete,
the insertion point is moved to the corresponding location.

11.5 Multiband RTA

This is a real-time analysis tool that displays the frequency content of the sound currently being recorded.
The full frequency range (20Hz – 22kHz) is subdivided into 10, 20, or 30 bands according to a logarithmic
scale and the intensities of each band are displayed. The values are averaged over time in order to avoid
fluctuations which are too fast. The duration of this averaging can be chosen with the Speed menu.

11.6 Real-Time Spectrum

This is essentially the same as the Spectrum function, except that it works in real-time on the selected sound
input.

11.7 Oscilloscope

This tool allows you to display in real-time the waveform of the sound signal on the selected sound input.

11.8 Real-Time Sonogram

This tool works exactly like the Sonogram function, but it takes its input in real-time from the selected
sound input. The speed at which the display moves can be adjusted by clicking on the Settings item in the
toolbar.

11.9 Real-Time Waveform

This tool displays the amplitude of the signal of the selected sound input in real time. It is convenient for
monitoring the sound intensity of a recorded signal, in order to make sure that no clipping is occurring. The
speed can be adjusted as either 10, 20 or 40 frames / second (slow, medium, fast).

12 Miscellaneous functions

12.1 Memory management

The General preference pane contains the somewhat esoteric Maximal RAM usage setting. It allows you
to determine how much sound data AmadeusPro puts into memory before it starts using temporary files
instead. The advantage of using memory instead of temporary files is that it is much faster to access and
will therefore result in a much ‘snappier’ experience. This however is only true if a sufficient amount of
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memory is indeed available. If not, the system will use virtual memory instead, which is much less efficient
than using temporary files. As a general rule, keep the maximal RAM usage below about one quarter of the
total amount of RAM installed in your computer.

12.2 Version checking

The default behaviour of AmadeusPro is to regularly check for the availability of new versions of the
program if it detects an active internet connection. This check happens weekly, but you can either change
this frequency or disable it altogether in the Updates section of the preferences window. No personal
information is transmitted during these checks, they consist in simply accessing this file. If you don’t trust
what software companies tell you (and you would probably be wise not to take everything at face value) you
are of course welcome to check that this is true by using tcpdump or your favourite TCP/IP packet sniffer.

If a new version is detected, AmadeusPro can download the update and install it without any user inter-
vention. The default behaviour is to ask the user for permission before starting the download, but if the
Download updates automatically checkbox is checked, downloads will start automatically without warn-
ing. (It will however present a progress window through which the download can be cancelled.) Installing
the download then requires AmadeusPro to quit and relaunch itself. If your user account does not have
sufficient privileges to erase the old version of AmadeusPro and replace it by the new version, you will be
asked for an administrator password.

Whenever AmadeusPro checks for the presence of a new version of the application, it also checks for
new versions of the manual. If a new version is detected, you will be given the opportunity to install it
onto your system. The manuals are kept in the Application Support/Amadeus Pro subfolder of your
Library folder. The reason for keeping the manual separately from the application is to save bandwidth.
The manual currently exists in four languages, but an individual user is unlikely to need more than one of
them. Furthermore, the manual is usually not updated between minor releases of the application.

12.3 Updates of the manual

Whenever AmadeusPro checks for a new version of the program, it also checks whether an updated version
of this user’s manual is available. If there is, you will be notified and asked whether you want to download
it. If you decline, you will be asked again the next time that AmadeusPro checks on it.

12.4 About the licensing system

12.4.1 Purchasing a license

Payments for AmadeusPro are handled by the payment processor Kagi and all network connections are
secured with the latest encryption technology. There are two ways of purchasing a license for AmadeusPro:

1. Online purchase. The online shop at https://order.kagi.com/?L851 provides the most flexible way of
purchasing an AmadeusPro license. Besides accepting all major credit cards, it also accepts various
alternative payment forms, like cash, checks, and payment orders. The online shop is also the only
way of purchasing site licenses and multiple licenses.

Your license will be included in an email with the subject Thanks for your purchase sent to you
by Kagi. Please make sure to set up your spam filter in such a way that this message does not get
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discarded! Once you have a valid license, open AmadeusPro and click on Register Now... when
presented with the initial ‘This copy of Amadeus is unregistered!’ dialog. Make sure to enter both
your name and your license key exactly as they appear in the ‘Thanks for your purchase’ email. Since
licenses are tied to the customer’s name, using a different name will result in the license being rejected.

2. In-program purchase. An other way to purchase a license for AmadeusPro is directly from within
the application. This has the advantage of streamlining the registration procedure. Click on Register
Now... when presented with the initial ‘This copy of Amadeus is unregistered!’ dialog. Then, click
on the Buy Now... button. This will bring up a dialog asking for your registration and credit card
details. An active internet connection is required for this!
After the license has been successfully purchased, it will automatically be entered in the registration
dialog by AmadeusPro. A copy will also be sent to you in an email with the subject ‘Thanks for your
purchase’.

Important Note: There will be no physical shipment taking place in any case. The latest version of
AmadeusPro can be downloaded on the HairerSoft website. The address that you enter during the reg-
istration process will only be used by the fraud prevention mechanism to verify that your credit card is
valid.

12.4.2 License management

The Amadeus Pro menu gives you access to a license manager that shows which licenses for AmadeusPro
are installed on your system:

For example, the above system has one single-user license for ‘Martin Hairer’ and one site license for
‘HairerSoft’. Site licenses are accessible to all users on the system, whereas single-user licenses are only
accessible to one user.

The license manager allows you to add new licenses and to remove existing licenses (for example, you
should remove your license before giving your computer away).

The most important part of the single-user license agreement is:

Grant of License. HairerSoft hereby grants to you, an individual purchasing
a single-user license, the right to install and activate AmadeusPro on up to
three separate computers for your personal use. Sharing this Software with
other individuals is in violation of this license.

In a nutshell, one single-user license allows you to use AmadeusPro on your laptop, your home computer
and your work computer. However, if your spouse wishes to use AmadeusPro as well, two licenses are
required. The precise terms of the single-user license can be found at this link.
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Similarly, the most important part of the site license agreement is:

Grant of License. HairerSoft hereby grants to you, the organization / school /
company / university purchasing a site license, the right to install and activate
AmadeusPro on an illimited number of computers belonging to you, provided
they are located within a radius of 10km of each other. It can be used on
these computers by any individual affiliated to you. Sharing this Software with
individuals not directly affiliated to you is in violation of this license.

So, if you are an arts school purchasing a site license, your staff and students can use AmadeusPro on the
university-owned computers on campus. Your are however not allowed to give away copies of the license
for the staff / student’s use on their personal computers. Also, if you have a second campus in another town,
you will need a second site license. The precise terms of the site license can be found at this link.

12.4.3 Upgrading from Amadeus II

Registered users of Amadeus II are entitled to purchase an upgrade license for AmadeusPro at a discounted
price ($25 instead of $40). If you purchase a license from within AmadeusPro by clicking on the Purchase
now... button in the registration dialog and a valid Amadeus II license is detected on your system, you will
automatically be led to the purchase of an upgrade license. Otherwise, you will be led to the purchase of
a regular license. If this is not what you want, please purchase the requested type of license in the online
shop.

An upgrade license is only valid together with an Amadeus II license. If AmadeusPro cannot detect the
presence of a valid Amadeus II license on your system, it will ask you to enter your Amadeus II license
when registering.

12.4.4 Lost licenses

First of all, please keep your license in a safe place. There is no guarantee that a lost license can be
replaced. If it happens nevertheless that your license is lost, you can request a copy of it by sending an
email to LostLicense@HairerSoft.com. Please include in your message both your name and the email under
which you originally registered AmadeusPro. In order to avoid fraud, replacement licenses will always be
sent to the email that you originally used to register AmadeusPro.

If you change your email address, please send an email from your old account to ChangeEmail@HairerSoft
.com. This email should contain your new address in the body. A confirmation email will be sent to both
your old and your new address confirming the change.

The procedures described in this section are not fully automated and it may therefore take several
working days before you get a reply.

13 How to’s

13.1 How to work with your iTunes music library

There is nothing easier than editing a sound from your iTunes music library:
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• Right-click (or control-click) on the song in iTunes and select Show in Finder from the contextual
menu.

• Drag the file from the Finder onto the AmadeusPro icon in the dock.

• After you are done editing the sound, just select Save in the File menu to save the sound back to the
same place.

In order to move a file edited with AmadeusPro to iTunes, the easiest way is to either use the dedicated
Export to iTunes Library function from the File menu or to drag the file from the Finder onto the iTunes
library.

Warning: Apple does not allow third parties to read protected AAC files. Songs purchased on the iTunes
music store can therefore not be edited with AmadeusPro, unless they were purchased from iTunes Plus.
The easiest workaround to this situation is to burn the song to a CD with iTunes and then to open it from the
CD with AmadeusPro.

13.2 How to convert a sound from one file format to another

A very common operation is to convert a sound from one format to another one, for example to encode
a song from a CD to either Mp3 or M4a or to create FLAC files for archiving. Just open the sound into
AmadeusPro by using the Open command from the File menu or by dragging the icon of the sound you
wish to convert from the Finder onto the AmadeusPro icon in the dock.

Then select Save As... from the File menu and select the desired destination format in the pop-up menu
located at the bottom of that dialog. You may optionally wish to tweak the settings associated to that
particular format by clicking on the Settings... button. See Section 3 for a description of the various formats
and the settings that go with them.

13.3 How to create a CD from a tape or vinyl recording

It is possible to achieve this without ever leaving AmadeusPro and without installing any additional soft-
ware by following these steps:

• Record the tape or vinyl to a new document, as explained in Section 4.1. Make sure that the recording
is performed in stereo with a sampling rate of 44.1kHz.

• Optionally remove any background hiss or cracks as explained in Section 8.

• Place markers at the junctions between songs. In most cases, this can be done automatically with
the Generate Markers... function in the Selection menu. If this doesn’t work (for example in a live
recording), you can place them manually. Markers mark the beginning of a track, so that in most
instances you would want to place a marker at the very beginning of your file.

• Choose Burn to CD... from the Sound menu. The top part of this dialog allows you to choose which
markers to take into account for splitting the document into tracks. If you wish to create a CD with
gapless playback (when there are smooth transitions between songs), you should choose 0 as the gap
size. Otherwise, 2 seconds is a standard value. You can create a CD with CD-TEXT information
which will then display the name of the currently played song and the title of the album on certain CD
players. The title of a song will be given by the name of the marker which marks the start of the song.
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You should therefore make sure that there is a marker located at the very beginning of the document
as well.

If the document contains songs by different performers, it is possible to store this information within
CD-TEXT as well. You should choose either ‘Performer:Title’ or ‘Title (Performer)’ in the ‘Markers’
menu and name your markers accordingly. For example, if your document contains the song ‘Breathe’
performed by Pink Floyd, you should name the corresponding marker either ‘Pink Floyd: Breathe’ or
‘Breathe (Pink Floyd)’ depending on which naming convention you choose.

You can also write a media catalog number to the Audio CD. If you don’t know what this is, then you
will certainly not need this and you can safely ignore this option.

• After clicking OK, the standard system CD burning dialog will give you the choice of which CD
burner to use and at which speed to burn the CD. Insert a blank disk and hit OK again. You are done.

Important: Before you can burn an AmadeusPro document to CD, you need to make sure that it consists
of a single stereo track and that its quality is 16 Bit / 44.1 kHz. If it consists of more than one track, please
use the Flatten Document function from the Sound menu in order to combine the tracks into one. If the
quality is different from 16 Bit / 44.1 kHz, use the Characteristics... function from the Sound menu to
adjust it.

13.4 How to record from the output of another program

Sometimes, you may wish to record the output of another program (for example iTunes or Safari). One
possible way of achieving this is to connect the sound output of your computer (the headphone port) back
into the line in input. This is however not very elegant and results in a slight loss of quality due to the two
analog / digital conversions that take place.

Solving this problem in a more elegant way is not possible without the help of some additional software.
One possible solution is to use the freeware Jack in conjunction with AmadeusPro. After downloading
Jack from http://www.jackosx.com/ and installing it, you can record sound from the output of, say iTunes,
by following the steps below. This procedure has been tested with iTunes 7 and JackPilot 0.74; other
versions may behave in a slightly different way.

Important: Do not use this procedure to import a sound from your iTunes library into AmadeusPro, unless
it is a protected AAC file. For unprotected files, use the procedure described in Section 13.1.

1. Make sure that AmadeusPro and iTunes are both closed.

2. Open the JackPilot program.

3. Go to the JackPilot preferences and choose Built-In Output (or whatever your preferred output device
is) in Interface. Also make sure that the option Auto-Connect with physical ports is unchecked.

4. Click on Save in the preferences window and then start the Jack daemon by clicking on Start in the
JackPilot window.

5. Open the Sound panel in the system preferences and choose Jack Router as the default output.

6. Start iTunes and AmadeusPro.
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7. Open the AmadeusPro Sound preferences and choose your preferred output device (for example
Internal Speakers) in the Output panel and Jack Router in the Input panel.

8. Choose Record to New File... in the Sound menu (or option-click on the record button).

9. Bring the JackPilot application to the front and click on Routing.

10. Click on the little arrow next to iTunes in the Send Ports column in order to expand it and select the
first port (labelled out1).

11. Click on the little arrow next to AmadeusPro in the Receive Ports column in order to expand it
and double-click on the first port (labelled in1). It should turn red and an entry should appear in the
Connections column.

12. Repeat steps 10 and 11 for the second port (out2 and in2).

13. Start your recording in AmadeusPro. Enable the Playthrough function in the recording window in
order to hear the sound you are going to play.

14. Start playing a song or a radio station in iTunes.

Note that it is also possible for example to create a virtual four-channel device with Jack. In this way, you
can for example route the output of iTunes into the first two channels and your microphone into the last two
channels. It is then possible to record all four channels simultaneously with AmadeusPro in order to create
a document with a vocal and a music track.

13.5 How to add a voice track to an existing music track

Starting from version 1.2 of AmadeusPro it is very easy to add a voice track to an existing music track in a
perfectly synchronised way:

1. Open the music track from your hard disk.

2. Set AmadeusPro up to record from your microphone (see also Section 4.1).

3. Choose Record to New Track... in the Sound menu.

4. If recording does not start immediately, click on the red recording button. This will automatically
start the playback of the existing music track.

5. Give your best to create a beautiful voice track!

6. Once the music stopped playing, click on Stop. This should add a new track to the existing document.

7. Play back your recording and adjust the relative volumes of the two tracks by playing with the Volume
gliders.

8. If you want to mix the music and the voice into one single track (this is optional, but recommended
before saving to an AIFF or Mp3 file), choose Flatten Document in the Sound menu.
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14 Troubleshooting

The most common causes for problems concern the recording / playback functions since these are the ones
where it is easiest to change the settings by mistake in such a way that the resulting behavior appears
strange...

14.1 I can’t hear anything when playing back

1. Check that you have selected the correct output device in the Output tab of the Sound preference
panel. (We are talking about AmadeusPro’s preference panel here, not the system one! The settings
there override those in the system preferences.)

2. Make sure that the Play checkbox is checked for the track that you are playing back and that its
volume is sufficiently high.

3. Reboot your computer. It happens (rarely, but still) that the audio driver gets into a strange state and
refuses to work properly.

4. If you are using external hardware for playback, check that it is connected properly to your computer.
Can you get iTunes to play back through it?

5. It might be that you are not directing sound to the correct hardware channels. Change the channel as-
sociation in the Advanced Settings dialog accessible from the Output pane of the Sound preferences
panel.

14.2 I don’t hear what I am recording

1. Make sure that the Playthrough checkbox is ticked in the recording window.

2. Follow the steps above to make sure that playback works.

3. Are the vu-meters moving? If not, follow the steps below to make sure that recording works.

14.3 I can’t record anything or the recording is not what I expect

1. Check that you have selected the correct input device in the Input pane of the Sound preference
panel. (We are still talking about AmadeusPro’s preference panel here, not the system one.)

2. Make sure that the Gain sliders are sufficiently far to the right.

3. If you are using external hardware for recording, check that it is connected properly to your computer.
Do the vu-meters move if you select that device in the Input tab of the Sound system preferences
panel?

4. If you are using a microphone, make sure that it either includes a preamplifier or that it is connected
to a ‘microphone’ input. Most models of Macintosh have a ‘line-in’ input instead which does not
include a preamplifier. One of the cheapest preamplifiers around is the iMic from Griffin’s. (Make
sure that the little black switch on it is in the correct location.)

5. If you are using the Record to new File... function, make sure that you have selected the desired
quality (including the channel configuration) in the Quality tab of the recording window.

Copyright c©2009 HairerSOFTHairerSOFT

http://en.wikipedia.org/wiki/VU_meter


TROUBLESHOOTING 44

6. If you are using the Record or the Record to new Track function, it will create a recording with the
same characteristics of the currently selected audio track. Make sure that this is what you want.

7. As above, it might be that you are not recording sound from the correct hardware channels. Change
the channel association in the Advanced Settings dialog accessible from the Input pane of the Sound
preferences panel or equivalently from the Input pane of the Record to new file window.

8. Reboot your computer, it might be that the audio drivers got into a ‘bad’ state.

14.4 Frequently Asked Questions

A list of frequently asked questions is maintained at the following adress:

http://www.hairersoft.com/AmadeusPro/AmadeusProFAQ.html

Furthermore, tips and discussions on using AmadeusPro can be found on the user’s forum at

http://www.hairersoft.com/forum/

The remainder of this section contains the state at the time of “printing” of the FAQ:

14.4.1 What is the upgrade policy for registered users of Amadeus II?

Registered users of Amadeus II can purchase AmadeusPro for US$25 instead of the usual price of US$40.
They will be issued with that special registration code that only works together with a valid registration code
for Amadeus II.

14.4.2 What are the differences between Amadeus II and Amadeus Pro?

The main differences are:

• AmadeusPro is a Universal Binary, i.e. it runs at native speed on Intel Macs. However, it requires
MacOS 10.4 or later to run.

• AmadeusPro has a completely redesigned MacOS X - like Cocoa user interface.

• AmadeusPro allows multi-track editing and recording.

• AmadeusPro includes a batch processor.

• AmadeusPro can burn Audio CD’s directly from within the program.

There are many more small differences between the two and the best is to just try them out!
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14.4.3 Why are CD track names all wrong on CDs burned by Amadeus Pro?

They only appear so in iTunes. The reason is that instead of correctly reading the CD-TEXT information
contained on the CD (which is what a CD player does), iTunes tries to be smart and queries an online
database (Gracenote) that tries to recognise the CD based on the lengths of the tracks. Chances are that your
home-made CD will be matched with some completely unrelated commercial CD that just happens to have
the same (or similar) track lengths, thus the resulting garbage. Apart from lobbying Apple to fix that bug
(feature?) of iTunes, there’s not much that one can do. To be fair, one possibility would be to burn the CD
as a data CD instead of an Audio CD, but then most CD players wouldn’t play it.

As you can guess from the explanation, this problem is not specific to AmadeusPro at all. It is just the same
if you burn the CD with iTunes or any other other CD burning software.

14.4.4 Could you add a key shortcut for function XYZ?

Go to the “Keyboard and Mouse” system preferences panel. On MacOS 10.3 and later, it allows you to
assign key shortcuts to arbitrary menu items.

14.4.5 Isn’t it possible to undo actions in the repair center?

Yes it is! The reason why the Undo menu item can be grayed out is just because it applies to the frontmost
window, which might be the repair center instead of the sound window. So, just select the sound window
and you can undo as usual. You can also use the handy ‘z’ key shortcut (no command, just ‘z’) to undo and
‘Z’ to redo.

14.4.6 Function XYZ from Amadeus II is missing in Amadeus Pro. Are you going to add it?

The Filter... function from the effects menu is probably not going to be added back, since its functionality
is duplicated by the multiband equalizers. The 3D-spectrum analyzing tool will probably not be added back
either, since it didn’t seem to be used by sufficiently many users. I believe that all other functions that were
present in Amadeus II have been replaced by equivalent (or more powerful) functions in AmadeusPro. If
you disagree, please let me know.

14.4.7 The sliders for the record levels are greyed out on my computer and the input level is inap-
propriate, why?

These sliders directly control the hardware. Therefore, they are only active if your hardware actually does
provide gain control and the driver of your hardware implements it correctly. If your particular hardware
doesn’t support it, there’s nothing that one can do about it. You should be careful to adjust the level of
the signal to the correct level before it reaches your hardware (or using the controls of the hardware if it
has some). Also, make sure that you are actually using the correct sound input device. You can check
whether a particular device supports gain adjustment with the “Audio MIDI Setup” application in your
Applications/Utilities folder (select the device and check whether the input sliders there are greyed out).
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Note that the iMic has a little black switch that allows you to switch between microphone level input and
line-in level input. Make sure that this switch is in the appropriate position.

14.4.8 Do you accept PayPal payments?

Yes. Click here and follow the on-screen instructions. You will be issued with a valid license as soon your
payment has cleared, which should be instantaneous unless you are using an e-Cheque.

14.4.9 Is there an academic / nonprofit organisations discount?

I am sorry, but there isn’t any discount. The price of AmadeusPro has been fixed at the absolute minimum
that is still viable.

14.4.10 Amadeus attempts to make an internet connection at startup! What the heck?

Occasionally, Amadeus makes an http query to see whether a new version is available. What happens is
exactly the same as what happens when you click on this link (i.e. it just retrieves a piece of text). If you are
concerned about this or choose not to believe what I say, you can disable version checking in the ”Updates”
section of the AmadeusPro preferences.

14.4.11 I can not open m4p files purchased on the Music Store with Amadeus, why?

With QuickTime 6.5.1 (the update coming with iTunes 4.5), Apple decided without prior notice to forbid
third-party applications the access to m4p files. One workaround is to play the files in iTunes and to use
Jack to record the output from iTunes. Another workaround is to burn the file on an Audio CD and to open
it from there.

14.4.12 What is an RIAA curve?

In general, vinyl recordings are engraved with reduced bass levels and increased treble levels. In 1954, the
RIAA (Recording Industry Association of America) introduced a standard filter that was used on nearly all
phonograph recordings since then. The filter ”RIAA” available from ”Filters” in the ”Effect” menu allows
to compensate this filter in order to reproduce vinyl recordings in the correct way.

15 Acknowledgment to third party software

AmadeusPro relies on a number of third-party open source software packages. Its functionality would be
nowhere near what it is today without these fabulous gifts to the community. They are listed in this section,
together with the corresponding internet links and licensing information.
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15.1 Ogg Vorbis

The libraries VorbisLib and VorbisFileLib are licensed under a BSD-type license. Its terms are:

Copyright (c) 2002, Xiph.org Foundation

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

- Redistributions of source code must retain the above copyright notice, this list of conditions and the fol-
lowing disclaimer.

- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

- Neither the name of the Xiph.org Foundation nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IM-
PLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAM-
AGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SER-
VICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The libraries OggLib and VorbisEncLib are licensed under the LGPL (GNU Library General Public Li-
cense). For a copy of the LGPL, see the link

http://www.HairerSoft.com/LGPL.txt .

All the source code used to build these libraries can be obtained at

http://www.xiph.org/ogg/vorbis/download.html .

15.2 LAME

LAME is the package used to provide Mp3 encoding in AmadeusPro. LAME is licensed under the LGPL
(GNU Library General Public License). For a copy of the LGPL, go to the link

http://www.HairerSoft.com/LGPL.txt .

The LAME source code can be obtained at

http://www.mp3dev.org/mp3/ .

The copy of lame used in AmadeusPro uses a patch allowing to add a specified number of null bytes at the
beginning of a file. This is so that AmadeusPro can then write the metadata to the file by itself. This patch
can be obtained at

http://www.hairersoft.com/Downloads/lamepatch .
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15.3 mpg123

mpg123 is the package used to provide Mp2 and Mp3 decoding in AmadeusPro. mpg123 is licensed under
the LGPL (GNU Library General Public License). For a copy of the LGPL, see the link

http://www.HairerSoft.com/LGPL.txt .

The mpg123 source code can be obtained at

http://www.mpg123.de/ .

15.4 FLAC

FLAC is licensed under the LGPL (GNU Library General Public License). For a copy of the LGPL, see the
link

http://www.HairerSoft.com/LGPL.txt .

The FLAC source code can be obtained at

http://flac.sourceforge.net/download.html .

15.5 AtomicParsley

AtomicParsley is the software used to read and write metadata from and to Mp4 files. AtomicParsley is
licensed under the LGPL (GNU Library General Public License). For a copy of the LGPL, see the link

http://www.HairerSoft.com/LGPL.txt .

The AtomicParsley source code can be obtained at

http://atomicparsley.sourceforge.net/ .

15.6 MTCoreAudio

The MTCoreAudio framework is licensed under the following terms:

MTCoreAudio.framework is Copyright (c) 2004 by Michael C. Thornburgh zenomt@armory.com. All
rights reserved.

MTCoreAudio.framework and its source code may be used, modified, incorporated, et ceterated for free by
anyone for any purpose. I request, but do not require, that credit for any use of the code is given. I request,
but do not require, to be notified of the incorporation of this code into other works.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ”AS IS” AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
NO EVENT SHALL THE COPYRIGHT OWNER BE LIABLE FOR ANY DIRECT, INDIRECT, IN-
CIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
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PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIA-
BILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.

The MTCoreAudio source code can be obtained at

http://aldebaran.armory.com/ zenomt/macosx/MTCoreAudio/ .

15.7 AMPreferencePane

AMPreferencePane is free software available from

http://www.harmless.de/cocoa.php .

It is distributed under the BSD license.

Copyright (c) 2007, Andreas Mayer (andreas@harmless.de)

15.8 ILCrashReporter

ILCrashReporter is free software available from

http://www.infinite-loop.dk/developer/ .

It is Copyright (c) 2004 Claus Broch, Infinite Loop. All rights reserved.

The version used by AmadeusPro has been modified to fix a number of minor glitches. The source code
for the modified version can be found here.

16 Bug reporting

Even though I make every possible effort to track down bugs before a new version of AmadeusPro is
released, the complexity of the project makes it unavoidable that some of them slip through. If you believe
that you have found a bug in AmadeusPro, please report it to Martin@HairerSoft.com and I will make
every attempt to correct it. However, please make sure to respect the following guidelines that will make
things so much easier for both of us since I will be able to provide you with a more useful reply and there is
a much higher chance that I will actually be able to fix things:

• Make sure that you are using the latest version of AmadeusPro. It may well be that the bug has
already been fixed! You can check the number of the latest version (and of course also download
it) at http://www.hairersoft.com/AmadeusPro/. Please do however confirm in your email that you are
indeed using the latest version of AmadeusPro, as otherwise this will be first question I’ll ask you.

• Please check the FAQ and read this manual to make sure that your bug is not a well-known problem.
Example: Please don’t report the fact that AmadeusPro cannot read protected AAC files!
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• Describe the bug in a short but precise way and, if possible, include detailed step by step instructions
on how to reproduce it. State precisely what the observed consequences of your manipulations are
and what consequences you expected instead. Include as much relevant information as possible. This
usually comprises at least the version of your operating system and the characteristics of the sound
you were working with when the bug occured. Example: If the bug concerns the recording functions,
state precisely what hardware you are using for recording.

• If the bug leads to a crash of AmadeusPro, there should be a dialog appearing that gives you the possi-
bility of sending a crash log back to HairerSoft. Please do so, this will help improving future versions.
Adding information on what you were doing when the crash occured greatly helps in tracking down
the problem.

16.1 Disclaimer

Just to avoid getting into any sort of legal trouble, I have to mention that I am not responsible for any damage
or loss of data that may (however unlikely this is) be caused by this or any other version of AmadeusPro to
your computer, whether this damage is caused by incorrect operation or by a bug in the program.

Copyright c©2009 HairerSOFTHairerSOFT



Index

batch processing, 25
bitrate, 11, 14

characteristics, 6
clipping, 6
cracks, 28

decibels, 7, 33

favorite actions, 25
file format

AAC, 13
AIFF, 12
CAF, 13
FLAC, 13
Mp3, 14
Ogg Vorbis, 13
Sound Designer, 14
Wave, 12

frequency, 6

Lame, 14

mpg123, 14

noise reduction, 29

octave, 18
Oscilloscope, 36

period, 5
playback

device, 18
envelope, 8
speed, 17
volume, 18

Plug-ins
Audio Units, 20, 23
VST effects, 24

presets, 25

regular expression, 26

sample, 6
sampling depth, 6
sampling rate, 6
semitone, 18
sonogram, 34

spectrogram, 34
stereo sound, 6

waveform, 7

51


	Introduction
	Basic notions of sound editing
	What is a sound?
	How does a computer represent it?
	Sound intensities: dB versus percentages
	Anatomy of an AmadeusPro document
	Tracks
	Playback volume and envelope
	Selection
	Playback head
	Markers
	Metadata


	File Formats
	The Amadeus format
	The Wave format
	The AIFF format
	The QuickTime Movie format
	The NEXT/Sun format
	The AAC ADTS, MPEG-4, and Bookmarkable AAC formats
	The Apple CAF File format
	The FLAC file format
	The Ogg Vorbis format
	The Mp3 file format
	The SoundDesigner format
	About raw data
	Exporting markers
	iTunes support

	Sound recording and playback
	Sound recording
	Sound playback
	Adjusting the playback device

	Editing
	Navigation
	Basic editing
	Inserting silence
	Changing the characteristics of a sound

	Applying effects to a sound
	Echo
	Amplify
	Equalizers
	Fadings
	Normalizing a sound
	Reverse
	Audio Units
	Change Pitch and Speed
	Stereo Utilities
	VST Effects

	Maintaining a list of commonly used actions
	Working with presets

	Batch processing
	Managing tracks
	Moving and reordering tracks
	Creating and deleting tracks

	Sound Restoration
	Elimination of pops and cracks
	Elimination of a continuous background noise

	Key shortcuts
	Hidden preferences
	Sound analysis tools
	Spectrum
	Sonogram
	Waveform Statistics
	Find Maximum / Find Next Clipped Sample
	Multiband RTA
	Real-Time Spectrum
	Oscilloscope
	Real-Time Sonogram
	Real-Time Waveform

	Miscellaneous functions
	Memory management
	Version checking
	Updates of the manual
	About the licensing system
	Purchasing a license
	License management
	Upgrading from Amadeus II
	Lost licenses


	How to's
	How to work with your iTunes music library
	How to convert a sound from one file format to another
	How to create a CD from a tape or vinyl recording
	How to record from the output of another program
	How to add a voice track to an existing music track

	Troubleshooting
	I can't hear anything when playing back
	I don't hear what I am recording
	I can't record anything or the recording is not what I expect
	Frequently Asked Questions
	What is the upgrade policy for registered users of Amadeus II?
	What are the differences between Amadeus II and Amadeus Pro?
	Why are CD track names all wrong on CDs burned by Amadeus Pro?
	Could you add a key shortcut for function XYZ?
	Isn't it possible to undo actions in the repair center?
	Function XYZ from Amadeus II is missing in Amadeus Pro. Are you going to add it?
	The sliders for the record levels are greyed out on my computer and the input level is inappropriate, why?
	Do you accept PayPal payments?
	Is there an academic / nonprofit organisations discount?
	Amadeus attempts to make an internet connection at startup! What the heck?
	I can not open m4p files purchased on the Music Store with Amadeus, why?
	What is an RIAA curve?


	Acknowledgment to third party software
	Ogg Vorbis
	LAME
	mpg123
	FLAC
	AtomicParsley
	MTCoreAudio
	AMPreferencePane
	ILCrashReporter

	Bug reporting
	Disclaimer


